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FORMA01 - Travaux pratiques de la formation 
« Initiation » : modélisation d’une plaque trouée en 
élasticité linéaire et adaptation de maillage

Résumé :

Ce test 2D en contraintes planes quasi-statique permet une prise en main de la plate-forme Salome-Meca sur
un cas simple en élasticité linéaire.

Il  s’agit  d’une plaque rectangulaire homogène, trouée en son centre,  qui  est soumise à une traction à ses
extrémités.

Dans un premier  temps (modélisation A),  on indique comment  construire  la  géométrie  puis le  maillage et
comment mettre en données l'étude. Dans un second temps (modélisation B et C), on procédera à l'adaptation
du maillage. Enfin (modélisation D), on présente une solution alternative utilisant la méthode X-FEM.

Les énoncés des Travaux Pratiques de la formation (TP1) sont inclus dans ce document (voir les modélisations
A, B et C).
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1 Problème de référence
1.1 Géométrie

Il  s’agit  d‘une plaque rectangulaire,  comportant un trou, modélisée en  2D  contraintes planes. On
modélise seulement un quart  de la  plaque grâce aux symétries.  Les dimensions sont données en
millimètres.
  

   
      

 
 
 

 

  

1.2 Conditions aux limites et chargements

Conditions de symétrie :
La plaque est bloquée suivant Ox  le long du côté AG  et suivant Oy  le long du côté BD .

Chargement en contrainte imposée :
Elle est soumise à une traction P=100MPa  suivant Oy  répartie sur le côté FG . 

1.3 Propriétés des matériaux

Les caractéristiques sont : 
• Module d’Young E=200000MPa  
• Coefficient de Poisson =0,3  
• Limite d’élasticité : 200MPa  
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2 Solution de référence

2.1 Solution élastique

En élasticité, pour une plaque infinie, comportant un trou de diamètre a , soumise à un chargement

P  selon y  à l’infini, la solution analytique en contraintes planes et coordonnées polaires r ,  est
[bib1]  :
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En particulier, au bord du trou ( r=a ) : σθθ=P [(1+2cos2θ)]

Et le long de l’axe x  : 
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]
Numériquement, pour P=1MPa , et pour une plaque infinie, on a :

Point Composante Calcul MPa  

A  SIXX  σθθ (r=a ,θ=π /2)  –1

B  SIYY  σθθ (r=a ,θ=0)  3

Pour  une  plaque  de  dimension  finie,  les  abaques  [bib1]  permettent  d’obtenir  le  coefficient  de
concentration de contraintes, et on trouve que pour une traction de 1MPa ,  SIYY  maximum vaut
environ 3.03MPa  au point B .

2.2 Références bibliographiques

[1] Analyse  limite  des  structures  fissurées  et  critères  de  résistance.  F.  VOLDOIRE  :  Note
EDF/DER/HI/74/95/26 1995

[2] Stress concentration factors. R.E. PETERSON Ed. J. WILEY p150
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3 Modélisation A

3.1 Déroulement du TP

Il  s’agit  de mener à bien le calcul  élastique en générant la géométrie,  le maillage et le fichier de
commandes AsterStudy à l’aide de la plate-forme Salome-Meca.
La modélisation est C_PLAN élastique. Un quart de la plaque est modélisé. On définira également les
commandes nécessaires au dépouillement (tracés de courbes et post-traitements graphiques). 

3.1.1 Géométrie

On créera la face plane du quart supérieur droit de la plaque.

Lancer le module Geometry.

Les principales étapes pour construire cette géométrie sont les suivantes : 
• Pour définir  les contours de la  plaque, on peut,  par exemple,  utiliser l'outil  « Sketcher »

(Menu New Entity → Basic → 2D Sketch ) . Il est plus simple de commencer par le
point B  de coordonnées (10,0)  . En partant de B  , pour l’arc de cercle, utiliser Element
Type(Arc) et  Destination(Direction/Perpendicular) ,  et  définir  le  rayon  10  et
l’angle  et  le  rayon  90°.  On obtient  le  point  A   .  Puis utiliser  Element Type(Line) et
donner les autres points ( G , F , D ) par leurs coordonnées absolues. Terminer par Sketch
Closure. 

• On obtient alors un contour fermé  (Sketch_ 1 ) sur lequel on doit  construire une face (
Menu New Entity → Build → Face ) . La géométrie de la plaque est alors complète. 

• Construire  des groupes utiles pour le  calcul.  Ici  on construit  les 3 groupes des arêtes sur
lesquels s’appuieront les conditions aux limites (symétries et chargement) :  gauche pour le
bord AG  , haut pour le bord GF  et bas pour le bord BD .  Menu New Entity → Group
→ Create  Group :  Sélectionner  le  type  d’entité  géométrique  (ici  la  ligne,  edge)  et
sélectionner  le  bord  directement  dans  la  fenêtre  graphique,  ensuite  cliquer  sur  Add,  un
numéro d’objet doit alors apparaître. On peut changer le nom du groupe avant de le valider
par Apply. 

3.1.2 Maillage

On créera un maillage plan du quart supérieur droit de la plaque, en éléments d’ordre 2, pour avoir
une précision suffisante.

Lancer le module Mesh.

Les principales étapes pour générer le maillage sont les suivantes : 
• Construire le maillage ( Menu Mesh → Create Mesh ) . Sélectionner la géométrie à mailler

Face_1, puis choisir  Algorithm → NETGEN 1D-2D en ajoutant Hypothesis → NETGEN
2D Parameters. Dans cette hypothèse, sélectionner Fineness → Fine et cocher la case
Second Order avant de Apply. 

• Calculer le maillage (Menu Mesh → Compute ) . Une fenêtre des informations de maillage
doit apparaître, et on obtient alors un maillage libre. 

• Créer  les groupes de mailles  correspondants aux  groupes géométriques ( Menu  Mesh →
Create Groups from Geometry ) . Sélectionner tous les 3 groupes des arêtes sous
module Geometry et puis Apply. On obtient 3 groupes des arêtes sur le maillage. 

• Pour obtenir une meilleure précision, on va faire passer le maillage de linéaire à quadratique,
grâce à l’outil  « Modification -> Convert to/from quadratic ». Les plus curieux
peuvent comparer les différences de résultats entre les deux types d’éléments.

• (Facultatif) Exporter le maillage au format MED : selectionner Mesh_1 et cliquer droite, puis
choisir Export / MED file.
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Remarques :

Ce  maillage  est  suffisamment  fin  (avec  des  éléments  quadratiques)  pour  avoir  une  bonne
approximation de la solution en élasticité : par exemple si on compare σθθ  sur le bord du trou
par rapport à la solution analytique, on obtient un écart de moins de 5%.
 
La géométrie et les paramètres de maillage sont définis dans le fichier forma01a.datg associé
au test. Le maillage produit est stocké dans le fichier forma01a.mmed.

   

3.2 Création et lancement du cas de calcul (via AsterStudy)

Lancer le module AsterStudy.
Puis en colonne gauche, cliquer sur l'onglet  Case View. Dans la case Data Settings, cliquer à
droite  à  CurrentCase et  choisir  Add Stage.  C’est  dans  Stage_1 où  on  définit  le  fichier  de
commandes du cas de calcul. 

Nota : chercher des commandes par Menu  Commands → Show All or par les 10 catégories de
calcul :  Mesh,  Model Definition,  Material,  Functions and Lists,  BC and Load,  Pre
Analysis, Post Processing, Fracture and Fatigue, Output.

Les principales étapes pour la création et le lancement du cas de calcul sont les suivantes :
• Lire le maillage au format MED : Catégorie Mesh / Commande LIRE_MAILLAGE. Le maillage

dans le module MESH est disponible dans la liste. Sinon le bouton derrière permet de choisir
un maillage dans les répertoires.

• Orienter la normale du bord sur lequel le chargement de traction sera appliqué : Catégorie
Mesh / Commande  MODI_MAILLAGE / ORIE_PEAU_2D en affectant le groupe haut dans
GROUP_MA. On garde le même nom du maillage en utilisant reuse.

• Définir  les  éléments  finis  utilisés :  Catégorie  Model  Definition /  Commande 
AFFE_MODELE pour la  modélisation en contraintes planes 2D ( C_PLAN ). Ajouter un terme
dans  AFFE.  Dans  ce  terme,  affecter  OUI  à  TOUT éléments,  et  choisir  le  phénomène
MECANIQUE, et ajouter le terme de contraintes planes 2D ( C_PLAN ) dans la modélisation

• Définir le matériau : Catégorie  Material / Commande  DEFI_MATERIAU . Choisir  ELAS et
saisir les valeurs du module de Young et du coefficient de Poisson.

• Affecter  le  matériau :  Catégorie  Material /  Commande AFFE_MATERIAU. Définir  au
moins une option entre  MAILLAGE et  MODELE.  Ajouter un terme dans  AFFE,  et affecter le
matériau défini à TOUT.

• Affecter les conditions aux limites mécaniques et le chargement : Catégorie BC and Load /
Commande AFFE_CHAR_MECA : 
◦ pour la symétrie sur le quart de plaque :  DDL_IMPO. Pour le gauche,  DX=0, et pour le

bas, DY=0.
◦ pour la traction : PRES_REP. Pour le haut, saisir la traction à PRES (donc c’est négatif).

• Résoudre  le  problème mécanique  statique  linéaire  :  Catégorie  Analysis /  Commande
MECA_STATIQUE en  donnant  le  matériau  (CHAM_MATER),  la  modélisation  (MODELE),  les
conditions aux limites et le chargement (EXCIT). 

• Calculer le champ :  Catégorie  Post Processing /  Commande CALC_CHAMP en activant
reuse (pour garder le même nom de l’objet d’entrée dans la commande). C’est-à-dire qu’on
enrichira le concept issu de MECA_STATIQUE en reprenant le même nom. 
◦ pour le calcul du champ de contraintes : CONTRAINTE / SIGM_ELNO (contraintes par 

éléments aux nœuds), SIGM_NOEU (contraintes globales aux nœuds). 
◦ pour le calcul du champ de contraintes équivalentes :  CRITERES / SIEQ_ELNO (par

éléments aux nœuds), SIEQ_ELGA (par éléments aux points de Gauss), SIEQ_NOEU
(globales aux nœuds).

• Imprimer  les  résultats  d'un  calcul  au  format  MED :  Catégorie  Output /  Commande
IMPR_RESU . Ajouter un terme dans RESU, et choisir les résultats à imprimer. Définir le fichier
de sortie (.rmed) par UNITE.
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• Pour lancer le cas de calcul, en colonne gauche, cliquer sur l'onglet History View . Il faut
sauvegarder  l’étude  d’abord,  et  selectionner  CurrentCase. Ajouter  Stage_1 en
sélectionnant run (croix en vert). Avant de lancer, vérifier des paramètres de calcul souhaité
dans la case Run Parameters : temps limite de calcul, mémoire, version de code_aster etc. 

3.3 Post-traitement des résultats

Pour  visualiser  les  résultats,  deux  choix  sont  actuellement  disponibles :  onglet  Results dans
AsterStudy, et le module ParaViS. 

Choix 1   : Dans l’ onglet Results dans AsterStudy : 
On propose les post-traitements suivants :

• Importer le fichier de résultats ( Case Case View →  Data F ile s , cliquer droite sur le
fichier  de sortie  et  choisir Post-process . Par  défaut,  la  coloration de la  plaque par le
champ de déplacement DEPL , une amplification automatique est appliquée à la déformée de
la plaque. Pour visualiser bien la différence entre la forme initiale et la déformée, cliquer droit
à la fenêtre et choisir Show as / Wireframe . 

• D ouble cliquer le champ souhaité,  utiliser le boutton  Probe values on one or more
points or cells (symbole croix) pour vérifier les valeurs aux points A et B. 

• (facultatif) aller au module Paravis, on trouve l’état actuel de visualisation et aussi toutes les
actions historiques.

Choix 2 : Dans le module ParaViS :
On propose les post-traitements suivants :

• Importer le fichier de résultats (Case Case View →  Data Files, cliquer droite sur le fichier
de sortie et choisir Open in ParaVis. 

• Télécharger les résultats : Dans l’onglet Properties la colonne à gauche, choisir d’abord les
champs souhaités pour importer, et cocher l'option GenerateVectors, puis appliquer Apply.

• Visualiser le maillage initial (passer en représentation Surface With Edges). 
• Visualiser la déformée de la plaque ( Menu Filters  → Common → Warp By Vector avec

les options Vectors = results_DEPL_Vector et ScaleFactor = 100 avant Apply). 
• Visualiser le champ de contraintes par éléments aux nœuds ou au points Gauss : selectionner

le  résultat  importé,  puis  dans  le  Menu  Filters  →  Mechanics, choisir  l’option  de
visualisation souhaitée. 

Vérifier la valeur des contraintes au nœud B : si l'on retrouve un rapport 3 entre la contrainte σθθ  (=
σ yy ) au bord du trou et la force appliquée. Pour visualiser les résultats sur un nœud, activer  Hover
points on (comme la photo ci-dessous), et déplacer la souris au nœud souhaité. 

 

3.4 Grandeurs testées et résultats

Valeur des composantes de contraintes : 
 

Localisation Identification Référence (Analytique) Tolérance

Nœud B Contrainte SIYY 303,0 5,0%

Nœud A Contrainte SIXX -100,0 15,0%

 
Ces tests sur des valeurs analytiques sont doublés par des tests de non-régression
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4 Modélisation B 

4.1 Déroulement du TP

Il s’agit de mettre en œuvre l'adaptation de maillage à la suite d'un calcul élastique.
On repartira donc de l'étude réalisée lors de la modélisation A.

4.2 Adaptation de maillage 

Après avoir lancé le module AsterStudy, on modifie le fichier de commande pour ajouter le calcul
de l'indicateur d'erreur :

• Ajouter  les  résultats  d’erreur  avec  la  commande  CALC_ERREUR dans  la  catégorie  Post
Processing : choisir l’option ERME_ELEM en utilisant reuse.

• Relancer le calcul.

Pour visualiser  les champs de contrainte et d’erreur (composante  ERREST,  erreur totale),  on peut
effectuer  le  post-traitement  dans  l’onglet  Results (fortement  recommandé)  ou  dans  le  module
ParaVis. Les étapes dans le module ParaViS sont comme suivant :

• C ocher les champs à visualiser pour les charger avant d’appliquer  GenerateVectors  :
SIEF_ELGA , ERME_ELEM 

• Pour visualiser la composante SIYY du champ  SIEF_ELGA notamment au bord du trou :
Menu Filters  → Mechanics →  ELGA field To Surface et passer en représentation
Surface With Edges.  Pour  relever  la  position  de  la  valeur  maximale  (de  l'ordre  de
270MPa  ) :  Menu  Edit  → Find Data  et choisir  l’option  Cells dans le  champ crée
ELGAfieldToSurface,  selectionner  SIEF_ELGA_Vector(1)  représentant  SIYY  et  la
formule is max. 

• Visualiser la cartographie de l'indicateur d'erreur (champ ERME_ELEM , composante ERREST ,
erreur totale). 

On  retourne  au  module  AsterStudy,  on modifie  le  fichier  de  commande  pour  effectuer  une
adaptation de maillage et calculer ensuite directement la nouvelle valeur d'indicateur d'erreur :

• Catégorie  Post Processing /  commande  MACR_ADAP_MAIL pour  une  adaptation  de
maillage  de  type  RAFFINEMENT : on  nomme  le  nouveau  maillage  par
MAILLAGE_NP1=MAIL2, sélectionner le critère des éléments (option CRIT_RAFF_PE) à 10%
pour le paramètre d’adaptation :  RESULTAT_IN /  NOM_CHAM=ERME_ELEM /  sa composante
NOM_CMP = ERREST. 

• Enchaîner  ensuite  les  commandes  AFFE_MODELE,  AFFE_MATERIAU,  AFFE_CHAR_MECA,
MECA_STATIQUE, CALC_CHAMP et  CALC_ERREUR  sur  ce  nouveau  maillage  MAIL2
(Duplicate les  commandes  en  modifiant  le  maillage  et  d’autres  termes  concernants).
Attendtion : les noms des concepts de ces commandes ne doivent pas être identiques à ceux
d’avant, et ils ne dépassent pas 8 caractères.

• Imprimer les nouveaux résultats de calcul au format MED : Commande IMPR_RESU . 
• Lancer le calcul.

Pour visualiser les champs de contrainte et d’erreur, on peut effectuer le post-traitement dans l’onglet
Results (fortement recommandé) ou dans le module ParaVis. 

4.3 Grandeurs testées et résultats

Valeur des composantes de contraintes (SIGM_NOEU) avec le maillage initial et après une adaptation :

Maillage Localisation Identification Référence
(Analytique)

Tolérance

1 Nœud B Contrainte SIYY 303,0 5,0%
1 Nœud A Contrainte SIXX -100,0 15,0%
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2 Nœud B Contrainte SIYY 303,0 2,0%
2 Nœud A Contrainte SIXX -100,0 3,0%

Ces tests sur des valeurs analytiques sont doublés par des tests de non-régression. 
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5 Modélisation C

5.1 Déroulement du TP

Il  s’agit  de  mettre  en œuvre  une adaptation  de maillage  dans une boucle  python  sur  un calcul
élastique.

5.2 Adaptation de maillage

Après avoir lancé le module AsterStudy et à partir du fichier de commande de la modélisation A, on
ajoute une boucle python pour effectuer deux adaptations (Menu Operations → Text mode). On
pourra s'inspirer du fichier forma01c.comm.
On lance le calcul.

Après avoir lancé le module ParaViS, on effectue le post-traitement suivant : 
• Voir l'effet de l'adaptation sur le maximum de la composante SIYY du champ de contrainte.

Le maximum est maintenant de l'ordre de 280MPa .
• Visualiser la cartographie de l'indicateur d'erreur (composante ERREST, erreur totale).

5.3 Grandeurs testées et résultats

Valeur des composantes de contraintes pour le maillage initial et après une adaptation : 

Maillage Localisation Identification Référence
(Analytique)

Tolérance

1 Nœud B Contrainte SIYY 303,0 5,0%

1 Nœud A Contrainte SIXX -100,0 15,0%
2 Nœud B Contrainte SIYY 303,0 2,0%

2 Nœud A Contrainte SIXX -100,0 3,0%
3 Nœud B Contrainte SIYY 303,0 1,0%

3 Nœud A Contrainte SIXX -100,0 2,0%

Ces tests sur des valeurs analytiques sont doublés par des tests de non-régression. 
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6 Modélisation D

6.1 Déroulement du TP

Il s’agit de réaliser la simulation élastique sans mailler le trou, en utilisant la méthode X-FEM.
Pour cela,  on utilise  la  notion d’interface (délimitant  le  trou),  une interface étant  vue  comme une
fissure « infinie » (pas de front de fissure). L'interface est alors représentée par une seule Level Set
(Level Set Normale), séparant deux solides, sans contact sur l'interface. On modélise ainsi un trou
(vide) car le solide à l’intérieur est isolé du reste de la structure sur laquelle le chargement de pression
est appliquée. 

On générera la géométrie et le maillage et le fichier de commandes AsterStudy à l’aide de la plate-
forme Salome-Meca.
La modélisation est C_PLAN élastique. Un quart de la plaque est modélisé.

6.1.1 Géométrie

La géométrie est le quart supérieur droit de la plaque rectangulaire, sans trou. 

Lancer le module Geometry.

Les principales étapes pour construire cette géométrie sont les suivantes : 
• Pour créer la face, on peut, par exemple, utiliser l'outil « rectangle » ( Menu New Entity /

Primitives / Rectangle ) ,  puis éventuellement  la  translater (Menu  Operations /
Transformation / Translation ) . 

• Construire  les  groupes  d es  arêtes  sur  lesquels  s’appuieront  les  conditions  aux  limites
(symétries et chargement) ( Menu New Entity → Group → Create Group ) . Sélectionner
le type d’entité géométrique (ici la ligne,  edge ) et sélectionner le bord directement dans la
fenêtre graphique. Ensuite, cliquer sur Add . Un numéro d’objet doit alors apparaître. On peut
changer le nom du groupe avant de l e valider par Apply . Construire ainsi les 3 groupes de
bord utiles pour le calcul : gauche pour le bord AG  , haut pour le bord GF  et bas pour le
bord BD  . 

6.1.2 Maillage

On créera un maillage plan du quart supérieur droit de la plaque, en éléments d’ordre 2, pour avoir
une précision suffisante.

Lancer le module Mesh.

Les principales étapes pour générer le maillage sont les suivantes : 
• Construire le maillage ( Menu Mesh → Create Mesh ) . Sélectionner la géométrie à mailler,

puis l'algorithme NETGEN 1D-2D avec l'hypothèse NETGEN 2D Parameters . Dans cette
hypothèse, sélectionner Fineness → Fine et cocher la case Second Order . 

• Calculer le maillage  (Menu Mesh → Compute ) . 
• Créer les groupes de mailles  correspondants aux  groupes géométriques  ( Menu  Mesh →

Create Groups from Geometry ). Sélectionner tous  les  groupes  géométriques.  On
obtient 3 groupes d'arêtes sur le maillage. 

• Exporter le maillage au format MED. 
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6.2 Création et lancement du cas de calcul (via AsterStudy)

Lancer le module AsterStudy.
Puis en colonne gauche, cliquer sur l'onglet Case View . 

On définit le fichier de commandes du cas de calcul. 

Nota : Pour ajouter des commandes : Menu Commands → Show All . 

Les principales étapes pour la création et le lancement du cas de calcul sont les suivantes :
• Lire le maillage au format MED : Commande  LIRE_MAILLAGE . 
• Orienter le maillage sur le bord affecté par le chargement : Commande  MODI_MAILLAGE /

ORIE_PEAU_2D en utilisant le groupe hau t . 
• Définir  les  éléments  finis  utilisés :  Commande  AFFE_MODELE pour la  modélisation  en

contraintes planes 2D ( C_PLAN ). 
• Définir l'interface : DEFI_FISS_XFEM avec la forme de fissure ( FORM_FISS / ELLIPSE ) et

le type de discontinuité . 
• Créer l es éléments finis enrichis ( MODI_MODELE_XFEM ). Et nommer un nouveau nom du

modèle X-FEM. 
• Définir le matériau : Commande  DEFI_MATERIAU . 
• Affecter le matériau : Commande  AFFE_MATERIAU sur le modèle X-FEM. 
• Affecter les conditions aux limites mécaniques et le chargement :  AFFE_CHAR_MECA sur le

modèle X-FEM  : 
◦ pour la symétrie sur le quart de plaque : Enforce DOF (DDL_IMPO),
◦ pour la traction : FORCE_CONTOUR.

• Résoudre le  problème mécanique  statique  linéaire  :  Commande  MECA_STATIQUE sur  le
modèle X-FEM. 

• Créer le maillage : Commande POST_MAIL_XFEM . Et nommer un nouveau nom du maillage.
• Définir  les  éléments  finis  utilisés :  Commande  AFFE_MODELE pour la  modélisation  en

contraintes planes 2D ( C_PLAN ). E t nommer un nouveau nom du modèle. 
• Créer le résultat de visualisation :  Commande POST_CHAM_XFEM . Et nommer un nouveau

nom du résultat . 
• Calculer le champ  : Commande  CALC_CHAMP . 

O n enrichira le concept issu de POST_CHAM_XFEM en reprenant le même nom de concept. 
◦ pour le c alcul du champ de contraintes par éléments aux nœuds : CONTRAINTE / 

SIGM_ELNO . 
◦ pour  le  calcul  du  champ  de  contraintes  équivalentes  par  éléments  aux  nœuds :

CRITERES / SIEQ_ELNO.
◦ pour le calcul du champ de contraintes équivalentes par éléments aux points de Gauss : 

CRITERES / SIEQ_ELGA . 
• Imprimer les résultats d'un calcul au format MED : Commande  IMPR_RESU . 
• Pour lancer le cas de calcul, en colonne gauche, cliquer sur l'onglet History View . 

Remarque :
Les modes rigides du trou sont bloqués par les conditions de symétrie appliquées. Dans le cas
d'une modélisation de la plaque entière, il aurait fallu bloquer les modes rigides de la plaque et
aussi de ceux du trou.
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6.3 Post-traitement des résultats

Lancer le module ParaViS. 

On visualisera la déformée de la plaque puis les contraintes au bord du trou en se comparant avec la
solution de référence.

• Importer le fichier de résultats ( Onglet Data Files → Open in ParaVis avec l'option
GenerateVectors ). 

• Visualiser la déformée de la plaque ( Menu Filters → Common → Warp By Vector ) . 

On pourra éventuellement rajouter une étape de raffinement automatique de maillage pour améliorer
la précision des résultats.

Remarque :
Les modes rigides du trou sont bloqués par les conditions de symétrie appliquées. Dans le cas
d'une modélisation de la plaque entière, il aurait fallu bloquer les modes rigides de la plaque et
aussi de ceux du trou.

6.4 Grandeurs testées et résultats

Valeur des composantes de contraintes aux points A et B :

Pour cela, on calcule le champ SIGM_NOEU. Attention, la notion de SIGM_NOEU est particulière pour
X-FEM car les éléments générés pour la visualisation (par POST_CHAM_XFEM) ont des nœuds doubles
non connectés. On a donc plusieurs valeurs pour une position de nœud. Dans le cas présent, on a
deux nœuds localisés au point A (coté plaque) et deux nœuds localisés au point B (coté plaque). On
teste donc le min et le max pour chaque point.

 
Localisation Identification Référence (Analytique) Tolérance

Nœud A Contrainte SIXX -100,0 5,0%

Nœud B Contrainte SIYY 303,0 5,0%

Ces tests sur des valeurs analytiques sont doublés par des tests de non-régression.
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7 Synthèse des résultats

Ce test  montre  comment  mener  le  calcul  d’une structure élastique et  comment  extraire  en post-
traitement les grandeurs d'intérêt. Il met également en évidence le bénéfice à utiliser l'adaptation de
maillage pour améliorer la précision des résultats.
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